
Manual Supplement for 
B1500A/EasyEXPERT A.03.11



This document provides the supplemental information for supporting Agilent 
EasyEXPERT software revision A.03.11 and applicable to Agilent B1500A User’s 
Guide and Programming Guide.

• “Main Screen GUI”

• “Test Results Data Auto Export”

• “Text File Export settings”

• “Waveform Pattern Editor”

• “Desktop EasyEXPERT”

• “Data Backup and Recovery”

• “B1500A System Recovery”

• “Updating EasyEXPERT”

• “SPGU Voltage Monitor Capability”

• “SPGU Pulse Output and Voltage Measurement”
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Main Screen GUI
Main Screen GUI
File menu Provides the following four functions.

Import Test Setup... Opens a dialog box used to specify a test setup to 
import.

Export Test Setup... Opens a dialog box used to specify a destination 
file for exporting the present test setup.

Close Workspace Closes the work space and returns to the workspace 
configurator.

Exit Exits the EasyEXPERT software.

Data Display menu Provides the following three functions.

Show Data Display Opens Data Display used to display the test result 
data.

Manage Data Display... Opens Data Display Manager used to control the 
appearances of the Data Display windows.

Default Data Display 
Properties... Opens Data Display Properties used to set the 

default setting of the Data Display window.

Help menu Provides the following three functions.

About This Instrument... Opens the Configuration window.

About This Test... Opens the test description dialog box.

Agilent EasyEXPERT Help Opens the EasyEXPERT help window.

Application Test This tab selects the application test mode of EasyEXPERT. 

Classic Test This tab selects the classic test mode of the EasyEXPERT. 

Quick Test This tab selects the quick test mode of the EasyEXPERT. 

Data Display Opens Data Display used to display the test result data. EasyEXPERT always 
handles the test setup corresponding to the Data Display window now active or most 
recently activated.
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Main Screen GUI
Calibration Opens Calibration used to see the self-calibration results, to perform the 
self-calibration, or to perform the current offset cancel.

Configuration Opens Configuration used to see the module configuration, to see the self-test 
results, to perform self-test, to establish the GPIB connection with Agilent 
B2200A/B2201A/E5250A switching matrix, or to see the event log.

Switching Matrix Opens Switching Matrix Operation Panel used to control Agilent 
B2200A/B2201A/E5250A switching matrix.

Standby Opens Standby Channel Definition used to set the standby channel which is the 
channel to keep the specified output when the standby mode is ON and in the 
non-measurement state.

Single Triggers a single measurement. To abort measurement, click Stop button that 
appears instead of the Single button.

Append Triggers the append measurement. The measurement results will be appended to the 
Data Display window that shows the previous measurement results. The Data 
Display window can have maximum 10 layers for displaying measurement results. 
To abort measurement, click Stop button that appears instead of the Single button.

Repeat This button provides a different function depending on the status of the data record 
functions (Auto Record and Auto Export). 

If Auto Record and Auto Export is OFF, this button starts the repeat measurement 
immediately.

If Auto Record or Auto Export is ON, this button opens the Repeat Measurement 
Setup dialog box for setting the repeat measurement condition.

Run Option Opens the Run Option dialog box for setting the data record functions (Auto Record 
and Auto Export) and the Multi Display function.

Save Data This button will appear to the right side of the Run Option button if a measurement 
is performed when the data record functions (Auto Record and Auto Export) are 
OFF. Clicking the button will save the last measurement data as a test result record.

Count Displays the number of single measurements executed for the test setup now 
opened. Effective for the measurements triggered by both Single and Repeat.
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Main Screen GUI
Device ID This entry field is used to enter a string in the test record. The string can data ID, 
device ID, test ID, or anything you want.

Performing measurement and changing setup do not change the value in this field. 
Change the value if you want.

Save The button saves the present test setup into the present preset group as a new test 
setup of the group.

Recall The button recalls the selected test setup. This means opening and displaying the 
measurement definition of the selected test setup.

My Favorite Setup The test setups you create or modify MUST be saved to My Favorite group (preset 
group) to reuse them.

Click the My Favorite Setup button to display the menu that provides the following 
functions. Select the preset group by using the field below the button. The test 
setups can be recalled by using the area below the field.

Cancel Closes the menu.

Preset Group Provides the following seven functions.

Add New Preset Group Opens the Add Preset Group dialog box. Creates a new 
preset group and saves it as the specified name.

Rename This Preset 
Group Opens the Rename Preset Group dialog box. You can 

change the name of the present preset group.

Duplicate This Preset 
Group Opens the Duplicate Preset Group dialog box. Creates 

a copy of the present preset group and saves it as the 
specified name.

Delete This Preset Group You can delete the present preset group.

Import Preset Group... Opens the Preset Group Import dialog box. Imports the 
specified preset group.

Export This Preset 
Group... Opens the Preset Group Export dialog box. Exports the 

present preset group as the specified name.

Organize Preset Group... Opens the Organize Preset Group dialog box used to 
organize the preset group.

Rename You can change the name of the selected test setup.
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Main Screen GUI
Duplicate Creates a copy of the selected test setup.

Delete Deletes the selected test setup.

Delete All Deletes all test setups in the present preset group.

Flag Shows the flag, Important (!), Valid (#), or Questionable (?) set to the record. The 
top button sorts the test records by the flag.

While the Show Deleted Data function is enabled, the list area can show the test 
records in Delete-group. For the records, * is set to the column to the left of the Flag 
column. The top button sorts the list by *.

Setup Name Shows the test setup name. The top button sorts the test records by name, in 
lexicographical order.

Date Shows the date that the test result is recorded. The top button sorts the test records 
by date, in chronological order.

Count Shows the measurement count shown in the Count field. The top button sorts the 
test records by count, in numerical order.

Device ID Shows the string set to the record by using the Device ID field. The top button sorts 
the test records by device ID, in lexicographical order.

Remarks Shows the remarks set to the record. The top button sorts the test records by the 
remarks in the lexicographic order.

Auto Record OFF This indicator is located at the bottom of the EasyEXPERT main screen and is lit 
while the Auto Record (automatic data record) function is disabled.

Auto Export ON This indicator is located at the bottom of the EasyEXPERT main screen and is lit 
while the Auto Export (automatic data export) function is enabled.

SMU Zero ON This indicator is located at the bottom of the EasyEXPERT main screen and is lit 
while the SMU current offset cancel function is enabled.

Standby ON This indicator is located at the bottom of the EasyEXPERT main screen and is lit 
while the standby function is enabled (standby mode is ON).

Multi Display ON This indicator is located at the bottom of the EasyEXPERT main screen and is lit 
while the Multi Display function is enabled.
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Main Screen GUI
workspace name Field below the Results button shows the present workspace name.

Results This button provides the following functions. The list area shows the test records. 
The up or down arrow button is used to expand or reduce the list area.

Cancel Closes the menu.

Select All Selects all records.

Unselect All Unselects all records.

Display Data Opens the Data Display and displays the test result data 
of the selected record. Up to 15 windows can be 
opened by this function.

Recall Recalls the test setup of the selected record.

Filter Provides the following four functions.

Show Deleted Data Check this function to see the test records of both 
Save-group and Delete-group. To set the data group, 
see “Flag and Remarks” on page 8. 

Filter... Opens the Test Result Data Filter dialog box. You can 
filter the test records in the list area.

Expand Application Test 
Results Check this function to see all test records created by the 

test setups defined in an application test.

If a test record is exported when this function is not 
checked, the exported file will contain all records 
created by the test setups defined in an application test. 
However, if the test record is exported by the Export 
As Text File function, the exported file will contain 
only the test record of the application test.

Show All Append Data Check this function to see all test records created by the 
append measurement. In the test record list, S indicates 
the test records obtained by a single measurement, and 
A indicates the records obtained by an append 
measurement.

Transport Data Provides the following ten functions.

Import... Opens the Test Result Import dialog box. Imports the 
specified test record.
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Main Screen GUI
Export As Test Result... Opens the Test Result Export dialog box. Exports the 
selected test record as the specified name in the 
EasyEXPERT data format.

Export As Compressed 
Test Result... Opens the Compressed Test Result Export dialog box. 

Exports the selected test record as the specified name 
in the compressed EasyEXPERT data format.

Export As CSV... Opens the CSV File Export dialog box. Exports the 
selected test record as the specified name in the CSV 
format that can be read by a spread sheet software.

Export As XML Spread 
Sheet... Opens the XML Style Sheet Export dialog box. 

Exports the selected test record as the specified name 
in the XML spread sheet format that can be read by a 
spread sheet software.

Export in My Format... Opens the Export in My Format dialog box. Exports 
the selected test record as the specified name in the 
style converted by using the specified XSLT filter.

Export As Text File... Opens the Text File Export dialog box. Exports the 
selected test record as the specified name in the style 
defined on the Text File Export settings dialog box.

Text File Export Setting... Opens the Text File Export settings dialog box used to 
define the style of the test record exported by the 
Export As Text File function.

Folder Export... Opens the Test Result Data Folder Export dialog box 
used to export the selected multiple test records to the 
specified folder.

Auto Export Setting... Opens the Test Result Data Auto Export dialog box 
used to set the automatic data export function and the 
automatic data save function.

Edit Provides the following two functions.

Flag and Remarks Opens the Test Result Editor used to put the selected 
test record in Save-group or Delete-group. Also this 
dialog box can set a flag and remarks to the selected 
record. The available data flags are Important (!), Valid 
(#), and Questionable (?). 
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Main Screen GUI
Delete Puts the selected test records in Delete-group. The 
records can be displayed in the list area while the Show 
Deleted Data is checked.

Properties... Opens the Test Result Data Properties dialog box used 
to set the number of test records listed in the list area 
and the number of recoverable records in Delete-group.
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Test Results Data Auto Export
Test Results Data Auto Export
This dialog box appears by clicking Results > Transport Data > Auto Export 
Setting... and is used to set the data record functions (Auto Record and Auto 
Export).

There is the following check box at the top of this dialog box.

• Enable automatic data export to the specified storage device

Checking this box sets the Auto Export function (automatic data export) and enables 
the following GUI.

Destination for 
Export

Selects the folder used to save the exported test records. The Browse... button opens 
the Browse For Folder dialog box used to select the folder.

File Name Specifies the style of the file name for the exported test records.

File name is automatically generated by using Setup Name, Device ID, Count, and 
Date values defined in the main screen. If an impermissible character is used in a 
value, the character is automatically replaced with _ (underscore).

• Default Format: File name without extension is as follows.

Setup Name[Device ID(Count);Date]

Example: Id-Vd [cmos1(1) ; 1_22_2006 3_44_55 PM]

• Custom Format: You can specify the style by the File Name Format dialog box.

The File Name Format dialog box appears by clicking the Settings... button. In 
the dialog box, enter the desired style into the Format field, for example, the 
next example sets the same style as the Default Format.

Example: {0} [{3}({2}) ; {1}]

{0}: Setup Name

{1}: Date, mm_dd_yyyy hh_mm_ss AM/PM

{2}: Count

{3}: Device ID

File Type Selects the file type (data format).

Test Result EasyEXPERT data format
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Test Results Data Auto Export
Compressed Test Result Compressed EasyEXPERT data format

CSV CSV format

XML Spread Sheet XML spread sheet format

My Format Custom format created by the specified XSLT filter. The 
following two entry fields are available.

• My Format

Specifies the file name of the XSLT filter (XML style sheet) used to export test 
records. The Browse... button opens the Select XML Style Sheet File dialog box 
used to select the file.

• Extension of Output File

Enters the appropriate extension, or selects the extension from xml, txt, csv, or 
xls.

Text File Custom format defined in the “Text File Export settings” 
on page 12 dialog box. The Settings... button opens this 
dialog box.

Data Storage Remove a check from the following check box to disable the Auto Record function 
(automatic data record).

• Enable automatic data record to the internal storage device

OK Applies the setup, and closes this dialog box.

Cancel Cancels the setup, and closes this dialog box.

NOTE Automatic Data Record Output

When the automatic data record function is enabled, one test execution result is 
stored in one test record. For the classic test, one test result is stored in one test 
record. For the application test, all test results taken by executing one application 
test are stored in one test record. However, the automatic data export function using 
the Text File type exports the file for each test result.
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Text File Export settings
Text File Export settings
This dialog box is opened by clicking Results > Transport Data > Text File Export 
Settings... or the Settings button on the Test Results Data Folder Export dialog box 
or the Test Results Data Auto Export dialog box. This dialog box is used to define 
the style of the test record exported by the Export As Text File function.

Reset Applies the default value to the all setup items.

OK Defines and memorizes the present setting, and closes this dialog box.

Cancel Cancels and clears the setting changes, and closes this dialog box.

Miscellaneous, 
Save As

Specifies the delimiter (data separator) and file extension. CSV (comma separated, 
.csv, default), Text (tab separated, .txt), or Formatted Text (space separated, .prn).

Miscellaneous, 
Quotation

Specifies the quotation for the string values. Single (single quotes), Double (double 
quotes), or None (no quote, default). Even if None is specified, the string which 
contains delimiter and/or new line character will be double quoted.

Identification 
section

Record items which are used to identify and characterize the test record. They are a 
sub set of the meta data, test type, and test name. See Table 0-2 for the definition of 
the record items. Check the box for the items you want to record, and uncheck the 
box for the items you do not want to record. In the default, all items are checked.

The pull-down menu specifies the action for recording the items in the Identification 
section. See Table 0-1 to specify the action.

Table 0-1 Actions for Identification and Setup Data Items

Action Description

Save with measurement data The checked items are recorded in the test record 
with the measurement data. Default.

Do not save No item is recorded even if any box is checked.

Save as separate file The checked items are recorded in a separate file. 
The name will be the test record’s file name plus 
-s before the extension.
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Text File Export settings
Table 0-2 Identification Section Record Items

Setup data section Record items which describes the test conditions. They are the test parameters, DUT 
parameters, and analysis setup. See Table 0-5 for the definition of the record items. 
Check the box for the items you want to record, and uncheck the box for the items 
you do not want to record.

Tag information for the setup data is string value; TestParameter, DutParameter, or 
AnalysisSetup, which means the type of data put in the same row in the exported 
test record. If Tag information box is unchecked (default), the tag information is not 
recorded. Then, the setup parameter names, such as Channel.Unit, are recorded in 
the first column in the test record and the parameter values are recorded in the 
following columns. If the Tag information box is checked, the tag information is 
recorded in the first column and the parameter names and values are shifted to the 
next columns.

The pull-down menu specifies the action for recording the items in the Setup data 
section. See Table 0-1 to specify the action.

Item Description

Setup title Test setup name

Classic test 
name

Classic test name. I/V Sweep, Multi Channel I/V Sweep, I/V-t 
Sampling, C-V Sweep, SPGU Control, Switching Matrix Control, 
or Direct Control. This record item is exclusive against the 
“Application test name” record item.

Application 
test name

Application test name. This record item is exclusive against the 
“Classic test name” record item.

Test date Test execution date corresponding to the date part of the 
RecordTime meta data.

Test time Test execution time corresponding to the time part of the 
RecordTime meta data.

Device ID Device ID corresponding to the TestTarget meta data.

Count Test count corresponding to the IterationIndex meta data.

Flags Flags set to the test result data, corresponding to the Flag meta 
data.

Remarks Remarks set to the test result data, corresponding to the Remarks 
meta data.
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Text File Export settings
Measurement data 
section

Record items of the measurement data. It may contain the measurement parameter 
names, data units, and data size. See Table 0-6 for the definition of the record items. 
Check the box for the items you want to record, and uncheck the box for the items 
you do not want to record.

Tag information for the measurement data is string value; Dimension1, Dimension2, 
Data Name, Data Unit, or Data Value, which means the type of data put in the same 
row (in case of Rowwise orientation) or column (in case of Columnwise orientation) 
in the exported test record. The tag information will be recorded in the test record if 
the Tag information box is checked.

See Table 0-3 for the Rowwise orientation. All data relative to a measurement 
parameter will be put in the same column. The first column (ex. column A) contains 
the tag information. For the Columnwise orientation, see Table 0-4. All data relative 
to a measurement parameter will be put in the same row. And the first row (ex. row 
1) contains the tag information. If the Tag information box is unchecked (default), 
the tag information is not recorded and the measurement data is shifted.

Table 0-3 Rowwise Orientation Export Example

Table 0-4 Columnwise Orientation Export Example

A B C D E F

1 Dimension1 101 101 101 1

2 Dimension2 1 1 1 1

3 Data Name Vg Id Gm Vth

4 Data Unit V A S V

5 Data Value 0 4.55E-09 1.24E-10 1.23

6 Data Value 0.02 8.59E-09 5.25E-10

A B C D E F

1 Dimension1 Dimension2 Data Name Data Unit Data Value Data Value

2 101 1 Vg V 0 0.02

3 101 1 Id A 4.55E-09 8.59E-09

4 101 1 Gm S 1.24E-10 5.25E-10

5 1 1 Vth V 1.23

6

14 Manual Supplement for B1500A/EasyEXPERT A.03.11



Text File Export settings
Table 0-5 Setup Data Section Record Items (ON: checked, OFF: unchecked)

Table 0-6 Measurement Data Section Record Items (ON: checked, OFF: unchecked)

Item Description Default

Test parameters Test parameters defined by the classic test or the 
application test.

ON

DUT parameters DUT parameters defined by the application test. ON

Analysis setup Data Display setup status at and after the 
measurement, such as Graph configuration, Graph 
format, Graph text, Marker configuration, Cursor 
configuration, Line configurations, Pointer 
configuration, List configuration, and Scalar list 
configuration.

OFF

Item Description Default

Data names Measurement parameter name. ON

Data units Unit of measurement data. OFF

Size Dimension1 (VAR1 size) and Dimension2 (VAR2 size) 
of the measurement data.

OFF

Data values Record items can be specified by the following segments.

Segment Default

Data assigned to X-Y Graph ON

Data assigned to List Display ON

Data assigned to Parameter Display ON

User function defined but not displayed OFF

Analysis function defined but not displayed OFF

Any data referred to by the user function but not 
directly displayed 

OFF

Any data referred to by the analysis function but not 
directly displayed 

OFF
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Waveform Pattern Editor
Waveform Pattern Editor
This window is opened by several actions, for example by selecting New from the 
Pattern menu, and is used to create or edit the pattern data.

File menu Provides the following three functions.

Save Saves the pattern data.

Save As... Opens a dialog box used to specify a pattern name 
and save the pattern data.

Close Closes the Waveform Pattern Editor without saving 
the data.

Edit menu Provides the following seven functions.

Undo Undoes the last action.

Redo Cancels the Undo operation.

Add a New Point Adds a point.

Delete a Point Deletes the highlighted point.

Same Level As Left Point Sets the highlighted point to the same level as the 
left point.

Copy Pattern to Clipboard Copies the highlighted pattern data to the Clipboard 
in the tab-separated spreadsheet format.

Paste Pattern from Clipboard Pastes the tab-separated spreadsheet format data 
stored on the Clipboard.

Display menu Provides the following function.

Channel Opens the Display Channels dialog box used to 
select the SPGU channels displayed on the 
Waveform Pattern Editor. This function is available 
if the Waveform Pattern Editor was opened with the 
column data.
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Waveform Pattern Editor
Pattern Editor Defines the pattern data. The Pattern Editor provides two methods, graphic mode 
and tabular mode, for defining the pattern data. 

In the graphic mode, you can define the pattern data by using the mouse pointer and 
GUIs on the graph (on the left side of the Pattern Editor).

In the tabular mode, you can define the pattern data by entering Time in seconds, 
Level in V, and Switch 0 (pulse switch open) or 1 (pulse switch close) into the table 
(on the right side of the Pattern Editor).

The Delta Time check box and the Delta Level check box are used to switch the data 
expression in the table. If the box is not checked, the value will be an absolute value; 
if the box is checked, the value will be the difference from the previous point.

The Pattern Editor provides the following buttons.

Undo Undoes the last action.

Redo Cancels the Undo operation.

Add a New Point Adds a point.

Delete a Point Deletes the highlighted point.

The Pattern Editor also provides the following functions in the menu displayed by 
right-clicking the area.

Cancel Closes the menu.

Save Saves the pattern data.

Edit Displays the Edit menu.

Display Displays the Display menu.

If the Pattern Editor is opened with the column data, the following GUI will be 
available.

Ref Ch. Specifies the channel or the pattern which contains the 
reference point.

Ref Pt. Specifies the reference point by the index number (No. column 
of table).

Delta T Displays the difference from the reference point. For time data.

Delta V Displays the difference from the reference point. For level data.
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Desktop EasyEXPERT
Desktop EasyEXPERT
The Desktop EasyEXPERT software CD-ROM is included with Agilent B1500A. 
This section describes the following topics.

• “About Desktop EasyEXPERT”

• “System Requirements”

• “To Install Desktop EasyEXPERT”

• “Before Starting Desktop EasyEXPERT”

• “To Start Desktop EasyEXPERT”

• “Execution Mode dialog box”

• “Start EasyEXPERT window”

• “To Change Execution Mode and GPIB Settings”

• “To Move the EasyEXPERT Database”

• “Using 4155B/4156B/4155C/4156C”

NOTE Desktop EasyEXPERT Standard Edition

There are two editions Plus and Standard for Desktop EasyEXPERT. The Standard 
edition does not support the Agilent E5250A Switching Matrix.

NOTE Software Update and Database Backup

To perform software update of Desktop EasyEXPERT, see “Updating 
EasyEXPERT” on page 36.

To make and restore EasyEXPERT database, see “Data Backup and Recovery” on 
page 28.
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Desktop EasyEXPERT
About Desktop EasyEXPERT
The Desktop EasyEXPERT software provides the following additional advantages 
to the B1500A, allowing you to minimize the amount of offline tasks performed on 
B1500A and increase the working ratio for measurements.

• Allows B1500A to be controlled from an external computer via GPIB while 
online.

• Allows test setup to be created on an external computer while offline.

• Allows data analysis to be performed on an external computer while offline.

The Desktop EasyEXPERT can use the 4155B, 4156B, 4155C, or 4156C instead of 
the B1500A. Then, there are some differences in the functions and operations 
compared with when the B1500A is used. See “Using 4155B/4156B/4155C/4156C” 
on page 25.

Figure 0-1 Using Desktop EasyEXPERT

NOTE Desktop EasyEXPERT supports most B1500A/EasyEXPERT functions. However, 
some functions are not supported on an external computer due to differences in 
hardware and so on.

Desktop EasyEXPERT
Data server

Desktop EasyEXPERT
Data server
Print server

Network Printer

Line Printer

Clean Room Office

To export test record
To import/export test setup
via LAN

The B1500A cannot be controlled via LAN.Note:

LAN

LAN

LAN

HUB

To control B1500A
via GPIB

Agilent B1500A
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Desktop EasyEXPERT
System Requirements
The following are the minimum requirement for executing Desktop EasyEXPERT 
revision A.03.11 or later.

• Processor: Intel Celeron 2 GHz

• Memory: 512 MByte DDR266 

• Display: XGA 1024×768. SXGA 1280×1024 is recommended.

• Hard disk drive: 1 GB free space in the C drive, 10 GB (30 GB recommended) 
free space in a drive for test setup/result data storage.

• GPIB interface: Agilent 82350B GPIB interface or equivalent, for Online 
execution

• Operating system: Windows XP Professional SP2

• Software:

• Microsoft .NET Framework Version 2.0 Redistributable Package 

• Microsoft .NET Framework 2.0 Service Pack 1

• Agilent IO Library Suite 14.0 or 14.2, for Online execution

NOTE If your computer does not install all required software, install them in the above 
sequence.

If your computer does not install a software, install it and the following software. 
For example, if your computer does not install Microsoft .NET Framework 2.0 
Service Pack 1, install it and Agilent IO Libraries (if you use the Online execution 
mode) in this sequence.

Prepare the Agilent IO Libraries software CD-ROM provided with Agilent GPIB 
interface to install the IO Libraries.

Open the Desktop EasyEXPERT Prerequisites folder to get installation packages for 
the other required software.
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Desktop EasyEXPERT
To Install Desktop EasyEXPERT
To install Desktop EasyEXPERT onto your computer, follow the procedure below.

1. Insert the Desktop EasyEXPERT software CD-ROM into the CD-ROM drive.

2. Execute Setup.exe and follow the instructions of the setup wizard.

3. Wait for installation to complete, and remove the CD-ROM from the CD-ROM 
drive.

NOTE To set the same module configuration as B1500A

The module configuration of the B1500A can be set to the Desktop EasyEXPERT in 
the offline mode. Copy the following file on the B1500A internal HDD to the same 
location on the PC which the Desktop EasyEXPERT runs.

\Documents and Settings\All Users\Application Data\Agilent 
Technologies, Inc\EasyEXPERT\UnitConfigB1500A.xml

Before Starting Desktop EasyEXPERT
Note the following when you use Desktop EasyEXPERT.

• When using the Offline mode, use the data import/export function to transfer 
your test setup data files and test result records.

• When using the Online mode, do not send a control command to the analyzer 
(B1500A, 4155B, 4156B, 4155C, or 4156C) by using a programming 
environment except for Desktop EasyEXPERT.

• Do not send a control command to the analyzer by using the GPIB IO statement 
in the application test definitions.

• To control the B1500A by using Desktop EasyEXPERT, exit EasyEXPERT on 
B1500A. The Start EasyEXPERT window (button) must be displayed or be 
minimized to the Windows task bar on the B1500A screen.
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Desktop EasyEXPERT
To Start Desktop EasyEXPERT
To launch Desktop EasyEXPERT, follow the procedure below.

1. Double click the Start EasyEXPERT icon or click Start > All Programs > Start 
EasyEXPERT. The Execution Mode dialog box is displayed.

2. Select the execution mode, Online or Offline.

If you select the Online mode, set the GPIB configuration. See  “Execution 
Mode dialog box” on page 22.

3. Click the OK button. The Start EasyEXPERT window is displayed.

4. Click the Start EasyEXPERT button to launch Desktop EasyEXPERT.

Execution Mode dialog box
The Execution Mode dialog box provides the following graphical user interface. 

Online Click the Online radio button to select the online execution mode. Then the 
following fields are available.

VISA interface ID VISA interface ID of the GPIB interface installed 
in your computer. Select one from the pop-up 
menu.

GPIB address GPIB address of the analyzer (B1500A, 4155B, 
4156B, 4155C, or 4156C). Select one from the 
pop-up menu. 0 to 30 are available.

Offline Click the Offline radio button to select the offline execution mode. And select the 
analyzer assumed by the Desktop EasyEXPERT in the offline mode.

Model Select B1500A, 4155B, 4156B, 4155C, or 4156C.

NOTE @ANALYZER Function

This function returns the present Model setting. It can be used in the application test 
definitions. The return value can be read by using a string variable (e.g. String1) as 
shown below. 

Example: String1=@ANALYZER

The return value is B1500A, 4155B, 4156B, 4155C, or 4156C.
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Desktop EasyEXPERT
Start EasyEXPERT window
The Start EasyEXPERT window provides the following graphical user interface.

Start EasyEXPERT This button launches Desktop EasyEXPERT.

File menu Exit closes the Start EasyEXPERT window.

Option menu Execution Mode opens the Execution Mode dialog box.

EasyEXPERT Database provides the following three functions.

• Backup EasyEXPERT Database

Opens the EasyEXPERT Database Backup Creation Wizard used to make 
backup of the EasyEXPERT database. You can make backup easily by following 
the wizard. Required time depends on the database size.

• Restore EasyEXPERT Database

Opens the EasyEXPERT Database Restoration Wizard used to restore the 
EasyEXPERT database backup. You can restore the backup easily by following 
the wizard. Required time depends on the database size.

• Move EasyEXPERT Database

Opens the EasyEXPERT Database dialog box used to move the EasyEXPERT 
database. To move the database, enter the destination folder name into the Move 
To field. For example, enter C:\EasyEXPERT_user_1\database.

EasyEXPERT Database is the folder used to store your test setup data and such. 
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To Change Execution Mode and GPIB Settings
To change the Desktop EasyEXPERT execution mode or the GPIB configuration, 
follow the procedure below.

1. Launch Start EasyEXPERT.

If the Execution Mode dialog box is not opened, click Option > Execution 
Mode.

If Desktop EasyEXPERT is running, exit it. And in the Start EasyEXPERT 
window, click Option > Execution Mode.

2. Select the execution mode, Online or Offline.

If you select the Online mode, set the GPIB configuration. See  “Execution 
Mode dialog box” on page 22.

3. Click the OK button to set the changes.

Click the Cancel button to cancel the setup changes.

To Move the EasyEXPERT Database
When the HDD (hard disk drive) is full, add a humongous HDD and move the 
EasyEXPERT database to it. To move the database, follow the procedure below. 
Required time depends on the database size.

1. Launch Start EasyEXPERT.

If the Execution Mode dialog box is opened, click the Cancel button.

If Desktop EasyEXPERT is running, exit it to open the Start EasyEXPERT 
window.

2. Click Option > EasyEXPERT Database > Move EasyEXPERT Database. The 
EasyEXPERT Database dialog box is displayed.

3. Enter the destination folder name into the Move To field. For example, enter 
C:\EasyEXPERT_user_1\database.

4. Click the OK button to start the database move operation.

Click the Cancel button to cancel the move operation.
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Desktop EasyEXPERT
Using 4155B/4156B/4155C/4156C
This section describes the notices when using Desktop EasyEXPERT and 
4155/4156.

4155/4156 
Firmware Revision

4155/4156 firmware revision supported by Desktop EasyEXPERT

•  HOSTC: 03.08 or later

•  SMUC: 04.08 or later

4155/4156 
Functions

4155/4156 functions unsupported by Desktop EasyEXPERT

• Log sampling measurement and Thinned out sampling measurement

• Functions using R Box

• Differential voltage measurement using VMU (Voltage Monitor Unit)

• DC bias output using PGU (Pulse Generator Unit)

• Other functions unavailable for the B1500A

Desktop 
EasyEXPERT

Classic tests available for 4155/4156

• I/V Sweep, I/V-t Sampling, and Switching Matrix Control for 4155C/4156C

• I/V Sweep and Switching Matrix Control for 4155B/4156B

Desktop EasyEXPERT functions unavailable for 4155/4156

• Functions using SMU Series Resistor

• Functions using ASU (Atto Sense Unit)

• Functions using SCUU (SMU CMU Unify Unit)

• Functions using CMU (Capacitance Measurement Unit)

• Functions using SPGU (Semiconductor Pulse Generator Unit)

PGU can be used instead of SPGU for the I/V Sweep and I/V-t Sampling classic 
tests. The Load Z function and the ALWG output are not supported. The Output 
Impedance dialog box is available to set the output impedance of the PGU.
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Calibration Differences on Calibration window

• Calibration window provides Module Self Calibration screen only.

• Module Self Calibration screen provides Enable Auto Calibration only.

Configuration, 
Main Frame

Differences on Configuration window Main Frame screen

• Line Frequency just displays the setting of 4155/4156.

• Firmware Rev. displays as follows.

[HOSTC Rev.]:[SMUC Rev.]:[ADC Rev.]

• Main Frame Diagnosis is not supplied.

Configuration, 
Module

Differences on Configuration window Module screen

• Self-test cannot be performed.

• Status, SCUU, and Notes columns are not supplied.

• Start Self Test and Recover Module buttons are not supplied.

• Accessory Configuration is not supplied.

I/V Sweep Differences on I/V Sweep Classic Test

• Time Stamp Name field is not supplied for 4155B/4156B.

• SMU Pulse Period and Width value must satisfy Period ≥ Width + 4 ms.

I/V-t Sampling Differences on I/V-t Sampling Classic Test

• Log sampling is not supported.

• Sampling interval must be 60 μs to 65.535 s.

• Number of samples must be 1 to 10001.

• Base hold time must be 0 sec.

ADC and 
Integration Time

Differences on A/D Converter & Integration Time Setup

• ADC always shows HR ADC.

• High Resolution ADC is set as shown in Table 0-7.

For the sampling measurement of Interval < 2 ms, the Integration Time setting is 
ignored.
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Advanced Setup Differences on Advanced Setup

• Series R always shows NONE.

• Wait Time Control is not supplied.

Restrictions for 
Standard Edition

There are the following restrictions for the Desktop EasyEXPERT Standard edition.

• I/V-t Sampling classic test is not supported.

• VSU, VMU, and PGU are not supported.

• Agilent E5250A Switching Matrix is not supported.

Table 0-7 Setting of High Resolution ADC

NOTE To reuse the test setup for B1500A

Perform the following procedure to reuse the test setup created for the B1500A.

1. Launch Desktop EasyEXPERT with the condition Set Analyzer=B1500A.

2. Export the test setups to be reused. And exit Desktop EasyEXPERT.

3. Launch Desktop EasyEXPERT with the condition Set Analyzer=4155B, 4156B, 
4155C, or 4156C.

4. Import the test setups exported at the step 2.

5. Set the channel for the analyzer to use.

Also, the procedure made by replacing the step 1 with the step 3 can be used to reuse 
the test setup created for the 4155/4156.

Mode Factor Setting of 4155/4156

AUTO - MEDIUM

MANUAL 1 ≤ N ≤ 127 SHORT, TIME=80 μs × N

PLC 1 MEDIUM

N ≥ 2 LONG, NPLC=N
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Data Backup and Recovery
Unexpected trouble of HDD (hard disk drive), operation mistake, or malfunction 
may cause elimination of valuable data. To avoid this kind of risk, make backup of 
data in the HDD as frequently as possible.

• “Folders to Backup”

• “To Make Database Backup”

• “To Restore Database Backup”

• “To Make Backup of Other Data”

• “To Restore Backup of Other Data”

NOTE Drive for making backup

Make backup into the storage device that has large free space and can be accessed 
by the B1500A directly. The device may be the D drive, a USB memory, an external 
HDD with USB interface and such.

If you make backup into the B1500A internal HDD, C drive or D drive, make a copy 
of the backup into an external storage device or backup media, CD-ROM, CD-RW, 
USB memory and such.
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Data Backup and Recovery
Folders to Backup
Backup should be made for the following data areas.

• EasyEXPERT database, below D:\Agilent\EasyEXPERT

D:\Agilent\EasyEXPERT\1

• Personal folders, below C:\Documents and Settings

Example: C:\Documents and Settings\B1500user

• Desktop EasyEXPERT user folder

Example: C:\Program Files\Agilent\B1500\EasyEXPERT\User

• Desktop EasyEXPERT database

Example: 
C:\Program Files\Agilent\B1500\EasyEXPERT\User\1

• Folders that store the data exported by EasyEXPERT or Desktop EasyEXPERT

• Other folders that store the data to be saved

To Make Database Backup
EasyEXPERT database backup can be made by the following procedure.

1. Launch Start EasyEXPERT.

2. Click Option > EasyEXPERT Database > Backup EasyEXPERT Database in the 
Start EasyEXPERT window.

3. Follow the EasyEXPERT Database Backup Creation wizard, and make backup 
into the D drive. The extension of the backup file is xdb.

4. Make a copy of the xdb file into an external storage device or backup media.

Example: COPY EasyEXPERT_backup_1.xdb F:\
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To Restore Database Backup
EasyEXPERT database can be restored by the following procedure.

1. Make a copy of the database backup file (xdb file) into the D drive.

2. Launch Start EasyEXPERT.

3. Click Option > EasyEXPERT Database > Restore EasyEXPERT Database in the 
Start EasyEXPERT window.

4. Follow the EasyEXPERT Database Restoration wizard, and restore the backup 
of EasyEXPERT database.

NOTE If the backup is not the xdb file

The backup for recovery must be “a copy of the folder that contains the 
EasyEXPERT database image”. And it must be stored in the location other than the 
following folders.

• D:\Agilent folder

• EasyEXPERT database folder

For the Windows backup (bkf file) or the compressed backup (zip file or other), 
uncompress the backup file at the location other than the above folders. And launch 
the wizard after the uncompression is completed.

Also, for the Backup Type Selection of the wizard, select “A Copy of the folder that 
contains the EasyEXPERT database image” and follow the wizard.
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To Make Backup of Other Data
There are the following three ways to make backup of data other than the 
EasyEXPERT database. Make backup by using one of the following methods.

• To use Windows backup program:

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the Backup or Restore wizard, and make backup into the D drive. 
The extension of the backup file is bkf.

3. Make a copy of the bkf file into an external storage device or backup media.

Example: COPY Mydata_backup_1.bkf F:\

• To make and copy a compressed file:

1. Make a compressed file for the whole folder to back up.

2. Make a copy of the compressed file into an external storage device or 
backup media.

Example: COPY Mydata_backup_1.zip F:\

• To copy a whole folder for backup:

1. Connect an external storage device, HDD with USB interface and such, to 
the B1500A.

2. Make a copy of the folder into the external storage device.

Example: XCOPY Folder_user_1 F:\Backup_user_1
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To Restore Backup of Other Data
Backups can be restored as shown below. The recovery method depends on how the 
backup was made.

• Backup is a bkf file:

1. Make a copy of the backup file (bkf file) into the D drive.

2. Click Start > All Programs > Accessories > System Tools > Backup.

3. Follow the Backup or Restore wizard, and restore the bkf file.

• Backup is a compressed file:

1. Make a copy of the compressed file into the D drive.

2. Uncompress the file at the place different from the original folder.

3. Copy all of the uncompressed files and folders, and paste them to the 
original folder.

• Backup is a whole folder:

1. Make a copy of the whole folder into the D drive.

Example: XCOPY F:\Backup_user_1 Backup_user_1

2. Delete the original folder.

Example: RMDIR /S Folder_user_1

3. Change the folder name to the original one.

Example: RENAME Backup_user_1 Folder_user_1
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B1500A System Recovery
If you find problems in the B1500A system, perform the system recovery. 

• “To Perform System Recovery”

• “To Initialize Database”

• “To Restore Database”

NOTE Before system recovery

After performing B1500A system recovery, the C drive will be returned to the 
condition when you received the B1500A or when it left the factory. To avoid 
deleting valuable data, Agilent Technologies strongly recommends to make backup 
of data in the C drive before starting the system recovery. See “Data Backup and 
Recovery” on page 28 for making the backup.

To Perform System Recovery
B1500A system recovery can be performed by the following procedure.

1. Set the B1500A Standby switch to the OFF position.

2. Disconnect all USB devices from the B1500A.

3. Connect the USB keyboard to a USB port of the B1500A.

4. Set the B1500A Standby switch to the ON position.

5. On the boot system selection menu, select Agilent Recovery System, and press 
Enter key. To select the system, use arrow keys.

The Command Prompt window is opened. See Figure 0-2.

Where, 2 is not valid now. 3 should be entered for rebooting the B1500A 
without performing system recovery.

6. For the message “Enter a Choice:”, enter 1 and press the Enter key. Message will 
be displayed for asking if you allow to overwrite the C drive.

7. For the message, enter 1 and press the Enter key. System recovery starts. After 
the recovery completes successfully, system boot starts automatically.

8. Perform “To Initialize Database” on page 34.

9. Perform “To Restore Database” on page 35.
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B1500A System Recovery
Figure 0-2 Agilent System Recovery Screen

Agilent Technologies System Utilities
Recovery Options

Choose one of the following:
-----------------------------------------------------------

1. Recover Factory Backup Image.
2. Update System.
3. Exit

-----------------------------------------------------------

Enter a Choice:

To Initialize Database
EasyEXPERT database can be initialized by the following procedure. You can use 
EasyEXPERT after this procedure is completed.

1. Exit Start EasyEXPERT.

2. Rename D:\Agilent\EasyEXPERT\1 folder (EasyEXPERT database).

Example:

CHDIR /D D:\Agilent\EasyEXPERT
RENAME 1 1-backup

3. Create D:\Agilent\EasyEXPERT\1 folder.

Example:

MKDIR 1

4. Copy all files and folders in the D:\Agilent\EasyEXPERT\Copy of 1 folder, and 
paste them to the D:\Agilent\EasyEXPERT\1 folder.

Example:

CHDIR Copy of 1
COPY * ..\1
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To Restore Database
EasyEXPERT database can be restored by the following procedure.

In the example shown in “To Initialize Database” on page 34, the EasyEXPERT 
database backup is the whole D:\Agilent\EasyEXPERT\1-backup folder. 
The database can be restored by using the data in this folder.

• For EasyEXPERT revision A.02.10 and earlier

The database reconfiguration tool is required. Obtain it from Agilent 
Technologies web site. For the execution procedure, see the readme text file 
included in the package.

• For EasyEXPERT revision A.02.11 and later

1. Launch Start EasyEXPERT.

2. Click Option > EasyEXPERT Database > Restore EasyEXPERT Database in 
the Start EasyEXPERT window.

3. Follow the EasyEXPERT Database Restoration Wizard and complete the 
restoration of EasyEXPERT database.
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Updating EasyEXPERT
NOTE The latest version of the EasyEXPERT update package can be obtained from 

Agilent Technologies web site.

Update procedure EasyEXPERT can be updated by the following procedure.

1. Make a backup of EasyEXPERT database. See “To Make Database Backup” on 
page 29.

2. If this is the update from the revision A.03.10 or earlier to the revision A.03.11 
or later, install the following software. They are included in the update package.

• Microsoft .NET Framework Version 2.0 Redistributable Package

• Microsoft .NET Framework 2.0 Service Pack 1

If they are already installed, go to the step 3.

3. Execute the setup program of the update package.

4. Follow the setup wizard and complete the update of EasyEXPERT.

5. After the update is completed, make a backup of EasyEXPERT database.

If update fails Perform the following procedure.

If EasyEXPERT could recover to the revision before starting the update procedure, 
skip the following step 1 to 2.

1. Perform system recovery. See “B1500A System Recovery” on page 33. This is 
not required for Desktop EasyEXPERT software.

2. Update EasyEXPERT to the revision before starting the update procedure.

3. Restore the backup made by the update procedure step 1. See “To Restore 
Database Backup” on page 30.

4. Perform the update procedure step 2 to 5.
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SPGU Voltage Monitor Capability
SPGU Voltage Monitor Capability
SPGU provides the function to monitor the channel output voltage. To monitor the 
voltage, use an external computer and execute the CORRSER? command. See 
“CORRSER?” and “SPGU Pulse Output and Voltage Measurement”. Also see 
Programming Guide.

• “Supplemental Information”

• “CORRSER?”

Supplemental Information
The following data shows the supplemental information of the SPGU output voltage 
monitor capability.

• Measurement resolution: approximately 2 V

• Measurement accuracy: ± (0.1 % + 25 mV), at open load and 1 PLC

CORRSER?
This query command monitors the SPGU channel output voltage and returns the 
measurement data and the calculated impedance data. Setting mode=1 automatically 
executes the SER command using this impedance data as the input parameter. Only 
one channel can be specified in this command. So the voltage monitor cannot be 
performed by using multiple channels simultaneously.

Execution Conditions
The SPGU output channel must be set up by using the following commands before 
executing this command.

• SPPER, SPM, SPT, and SPV commands, in PG mode

• ALW and ALS commands, in ALWG mode

The voltage must be measured in the first pulse or ALWG sequence output. In the 
PG mode, the pulse period must be more than delay + interval × count value.

Set the command parameters properly. The voltage must be measured at the output 
timing of the voltage effective for the automatic adjustment of the SPGU output 
voltage.
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SPGU Voltage Monitor Capability
Syntax
CORRSER? chnum,mode,delay,interval,count

Parameters
chnum : SPGU channel number. Integer expression. 1 to 10 or 101 to 1002. See 

Table 4-1, Programming Guide.

mode : Automatic execution modes of SER. Integer expression.

0: Does not execute the SER command (set the load impedance)

1: Executes the SER command (set the load impedance)

delay : Delay till start of measurement (seconds). Numeric expression. 
0 (initial setting) to pulse period -5E-6 seconds, setting resolution 
1E-8 seconds.

interval : Measuring interval (seconds). Numeric expression. 5E-6 (initial 
setting) to 0.001 seconds, setting resolution 2E-8 seconds.

count : Measurement repetitions (times). Integer expression. 1 (initial setting) 
to 65535 times.

Figure 0-3 Voltage Monitor and CORRSER? Setup Parameters

Query Response 
loadZ,voltage<CR/LF^EOI>

loadZ : Returns the impedance calculation data (Ω).

voltage : Returns the voltage measurement data (V).

delay interval

time

Ch1 output

Ch2 output

Start measurement

Meas[1] Meas[2] Meas[n]

delay + interval x n

Measurement value = average(Meas[n])

1 pulse width or 1 ALWG sequence

Pulse period >

n: count
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Remarks
Active SPGU outputs are stopped by the CORRSER? command.

Any other channels specified as SPGU output channels, but not specified in this 
command, will output synchronized to the CORRSER? command.

After executing the CORRSER? command, all SPGU channel outputs are changed 
to the following value.

• base value set by the SPV command, in PG mode

• initial value of waveform, in ALWG mode

Example Statements 
OUTPUT @B1500;"SPPER 10E-6"
OUTPUT @B1500;"SPM 101,1"
OUTPUT @B1500;"SPT 101,1,0,5E-7,20E-9"
OUTPUT @B1500;"SPV 101,1,-0.5,0.5"
OUTPUT @B1500;"CORRSER? 101,1,1E-7,1E-8,10"
ENTER @B1500;A,B

In this example, the voltage measurement data is returned to the variable B, and the 
load impedance calculation data is returned to the variable A.

See Also
“SER” and “SER?”, Programming Guide
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SPGU Pulse Output and Voltage Measurement
To control the SPGU channel, use the following commands.

Function Command Parameters 

Enables channels CN [chnum ... [,chnum] ... ]

Disables channels CL [chnum ... [,chnum] ... ]

Sets SPGU pulse output mode SIM 0

Sets output operation mode SPRM mode[,condition]

Sets pulse period for all of 
SPGU channels

SPPER period

Sets channel output mode SPM chnum,mode

Sets pulse timing parameters SPT chnum,src,delay,width,leading
[,trailing]

Sets pulse level parameters SPV chnum,src,base[,peak]

Sets load impedance SER chnum,loadZ

Monitors output voltage and 
sets load impedance

[CORRSER?] chnum,mode,delay,interval, 
count

Sets pulse switch [ODSW] chnum,state[,normal[,delay, 
width]]

Sets SPGU trigger output [STGP] chnum,state

Applies SPGU channel setup SPUPD chnum[,chnum ... [,chnum] ... ]

Starts SPGU pulse output SRP

Stops SPGU pulse output [SPP]

Returns SPGU output status [SPST?]
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SPGU Pulse Output and Voltage Measurement
The following program controls a SPGU to output 2-level pulse from the channel 1 
and 3-level pulse from the channel 2. This program can run without the project 
template (Table 3-1, Programming Guide).

Table 0-8 SPGU Pulse Output Example

Imports Ivi.visa.interop ’1

Module Module1

Sub Main()
Dim B1500 As IResourceManager ’6
Dim session As IMessage
B1500 = New ResourceManager
session = B1500.Open("GPIB0::17::INSTR")
session.WriteString("*RST" & vbLf) ’10
MsgBox("Click OK to start measurement.", vbOKOnly, "")
Console.WriteLine("SPGU setup." & Chr(10))

Dim sp_ch() As Integer = {101, 102} ’14
Dim duration As Double = 10
Dim loadz As Double = 1000000.0
Dim period As Double = 0.0001
Dim p1_del As Double = 0.00001
Dim p1_wid As Double = 0.00008
Dim p2_del1 As Double = 0.00001
Dim p2_del2 As Double = 0.00006
Dim p2_wid1 As Double = 0.00003
Dim p2_wid2 As Double = 0.00003
Dim p_lead As Double = 0.00000002
Dim p_trail As Double = 0.00000002
Dim p1_base As Double = 0
Dim p1_peak As Double = 3
Dim p2_base1 As Double = 0
Dim p2_base2 As Double = 0
Dim p2_peak1 As Double = 3
Dim p2_peak2 As Double = -3
Dim p_stat As Integer = 0 ’32

Line Description 

1 This line is required to use the VISA COM library.

6 to 9 Establishes the connection with the Agilent B1500 of the GPIB address 17 on the 
interface GPIB0. “GPIB0” is the VISA name. Confirm your GPIB settings, and set 
them properly.

10 Resets the B1500.

14 to 32 Declares variables and sets the value. This program uses the SPGU installed in the slot 
1 of the B1500.
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SPGU Pulse Output and Voltage Measurement
Dim msg As String = "No error." ’34
Dim err As Integer = 0

session.WriteString("CN " & sp_ch(0) & "," & sp_ch(1) & vbLf) ’SPGU ch on ’37
session.WriteString("SIM 0" & vbLf) ’PG mode
session.WriteString("SPRM 2," & duration & vbLf) ’Duration mode
session.WriteString("ODSW " & sp_ch(0) & ", 0" & vbLf) ’Disables pulse switch ’40
session.WriteString("ODSW " & sp_ch(1) & ", 0" & vbLf)
session.WriteString("SER " & sp_ch(0) & "," & loadz & vbLf) ’Load impedance
session.WriteString("SER " & sp_ch(1) & "," & loadz & vbLf)
session.WriteString("SPPER " & period & vbLf) ’Pulse period
session.WriteString("SPM " & sp_ch(0) & ",1" & vbLf) ’2-level pulse setup ’45
session.WriteString("SPT " & sp_ch(0) & ",1," & p1_del & "," & p1_wid & "," & 

p_lead & "," & p_trail & vbLf)
session.WriteString("SPV " & sp_ch(0) & ",1," & p1_base & "," & p1_peak & vbLf)
session.WriteString("SPM " & sp_ch(1) & ",3" & vbLf)  ’3-level pulse setup ’48
session.WriteString("SPT " & sp_ch(1) & ",1," & p2_del1 & "," & p2_wid1 & "," & 

p_lead & "," & p_trail & vbLf)
session.WriteString("SPT " & sp_ch(1) & ",2," & p2_del2 & "," & p2_wid2 & "," & 

p_lead & "," & p_trail & vbLf)
session.WriteString("SPV " & sp_ch(1) & ",1," & p2_base1 & "," & p2_peak1 & vbLf)
session.WriteString("SPV " & sp_ch(1) & ",2," & p2_base2 & "," & p2_peak2 & vbLf)
session.WriteString("SPUPD" & sp_ch(0) & "," & sp_ch(1) & vbLf) ’Apply setup ’53

Line Description 

34 to 35 Declares variables used for error check.

37 Enables the SPGU channels specified by sp_ch(0) and sp_ch(1).

38 Sets the pulse generator mode to all of the SPGU channels.

39 Selects the duration output mode.

40 to 41 Disables the pulse switch.

42 to 43 Sets the load impedance value.

44 Sets the pulse period for all of the SPGU channels.

45 to 47 Sets the channel specified by sp_ch(0) to the 2-level pulse output channel using the 
source 1, sets the pulse timing parameters, and sets the pulse level parameters.

48 to 52 Sets the channel specified by sp_ch(1) to the 3-level pulse output channel using the 
source 1 and 2, sets the pulse timing parameters, and sets the pulse level parameters.

53 Applies the setup to the channels specified by sp_ch(0) and sp_ch(1). The channels 
start the pulse base output.
42 Manual Supplement for B1500A/EasyEXPERT A.03.11



SPGU Pulse Output and Voltage Measurement
Measurement 
Result Example

SPGU setup.

SPGU output in progress..........................................
...............................................................
SPGU output stopped.

session.WriteString("ERRX? 0" & vbLf) : msg = session.ReadString(256) ’55
err = Val(Left(msg, 2))
If err <> 0 Then session.WriteString("DZ" & vbLf) : GoTo Check_err

session.WriteString("SRP" & vbLf) ’starts pulse output ’59
Console.Write("SPGU output in progress")

Spgu_stat: ’62
Console.Write(".")
session.WriteString("SPST?" & vbLf) : p_stat = session.ReadString(1 + 2)
If p_stat = 1 Then GoTo Spgu_stat
If p_stat = 0 Then GoTo Close

Check_err: ’68
MsgBox("Instrument error: " & Chr(10) & msg, vbOKOnly, "")

Close: ’71
Console.WriteLine(Chr(10) & "SPGU output stopped.")
session.WriteString("CL" & vbLf)
session.Close()
MsgBox("Click OK to stop the program.", vbOKOnly, "")
Console.WriteLine("Program completed." & Chr(10)) ’76

End Sub

End Module

Line Description 

55 to 57 Reads error buffer. If an error is detected, changes the channel output to 0 V and goes to 
Check_err.

59 Starts the SPGU pulse output.

62 to 66 Checks the SPGU pulse output status. And waits for the end status.

68 to 69 Clears the error buffer. And displays a message box to show an error message.

71 to 76 Disables all channels, and closes the connection with the Agilent B1500.
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The following program controls a SPGU to monitor the SPGU channel output 
voltage, calculate the load impedance, set it for the automatic output level 
adjustment, and output 2-level pulse voltage. This program can run without the 
project template (Table 3-1, Programming Guide).

Table 0-9 SPGU Voltage Measurement and Pulse Output Example

Imports Ivi.visa.interop ’1

Module Module1

Sub Main()
Dim B1500 As IResourceManager ’6
Dim session As FormattedIO488
B1500 = New ResourceManager
session = New FormattedIO488
session.IO = B1500.Open("GPIB0::17::INSTR")
session.IO.Timeout = 10000

session.WriteString("*RST" & vbLf) ’13
MsgBox("Click OK to start measurement.", vbOKOnly, "")
Console.Write("SPGU setup...   ")

Dim sp_ch() As Integer = {101, 102} ’17
Dim duration As Double = 5
Dim loadz As Double = 50.0
Dim period As Double = 0.0001
Dim p1_del As Double = 0.00001
Dim p1_wid As Double = 0.00008
Dim p_lead As Double = 0.0000001
Dim p_trail As Double = 0.0000001
Dim p1_base As Double = 0
Dim p1_peak As Double = 3
Dim p_stat As Integer = 0
Dim delay As Double = p1_wid / 8
Dim count As Double = 3
Dim interval As Double = (p1_wid - delay * 2) / count
Dim measv As Double = 3.0
Dim rval As String = "" ’32

Line Description 

1 This line is required to use the VISA COM library.

6 to 11 Establishes the connection with the Agilent B1500 of the GPIB address 17 on the 
interface GPIB0. “GPIB0” is the VISA name. Confirm your GPIB settings, and set 
them properly. Also sets the B1500 GPIB IO timeout.

13 Resets the B1500.

17 to 32 Declares variables and sets the value. This program uses the SPGU installed in the slot 
1 of the B1500.
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Dim msg As String = "No error." ’34
Dim err As Integer = 0

session.WriteString("CN " & sp_ch(0) & vbLf) ’37
session.WriteString("SIM 0" & vbLf)  ’ PG mode
session.WriteString("SPRM 2," & duration & vbLf) ’ Duration mode
session.WriteString("ODSW " & sp_ch(0) & ", 0" & vbLf) ’ Disables pulse switch
session.WriteString("SPPER " & period & vbLf) ’ Pulse period
session.WriteString("SPM " & sp_ch(0) & ",1" & vbLf)  ’ 2-level pulse setup
session.WriteString("SPT " & sp_ch(0) & ",1," & p1_del & "," & p1_wid & "," & 

p_lead & "," & p_trail & vbLf)
session.WriteString("SPV " & sp_ch(0) & ",1," & p1_base & "," & p1_peak & vbLf)
session.WriteString("SPUPD" & sp_ch(0) & vbLf) ’ Apply setup ’45
session.WriteString("ERRX? 0" & vbLf) : msg = session.ReadString() : err = 

Val(Left(msg, 2))
If err <> 0 Then session.WriteString("DZ" & vbLf) : GoTo Check_err
Console.Write("Completed." & Chr(10) & Chr(10)) ’48

session.WriteString("CORRSER? " & sp_ch(0) & ", 1," & delay & "," & interval & "," 
& count & vbLf)
rval = session.ReadString()
Console.WriteLine("Before compensation: LoadZ, TermV = " & rval)
session.WriteString("CORRSER? " & sp_ch(0) & ", 1," & delay & "," & interval & "," 

& count & vbLf)
rval = session.ReadString()
Console.WriteLine("After compensation:  LoadZ, TermV = " & rval)
session.WriteString("SRP" & vbLf) ’ Start pulse output ’56
Console.Write("SPGU output in progress")

Spgu_stat:
Console.Write(".")
session.WriteString("SPST?" & vbLf) : p_stat = session.ReadString()
If p_stat = 1 Then GoTo Spgu_stat ’62

Line Description 

34 to 35 Declares variables used for error check.

37 Enables the SPGU channels specified by sp_ch(0).

38 to 45 Defines the channel setup and applies them to the channel specified by sp_ch(0). The 
channels start the pulse base output.

46 to 47 Reads error buffer. If an error is detected, changes the channel output to 0 V and goes to 
Check_err.

50 to 55 Measures the terminal voltage, calculates the impedance, sets it to the channel specified 
by sp_ch(0), and displays the voltage and impedance. This is performed twice.

56 to 62 Starts the SPGU pulse output and checks the SPGU pulse output status. And waits for 
the end status.
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Measurement 
Result Example

SPGU setup... Completed.

Before compensation: LoadZ, TermV = +3.02579E+05,+6.029515

After compensation: LoadZ, TermV = +1.50844E+05,+3.004060

SPGU output in progress..........................................
...............................................................

After SPGU output:
Load impedance = 150865 ohm
Terminal voltage = 3.003394 V

SPGU output stopped.

Dim i, n As Integer ’64
session.WriteString("CORRSER? " & sp_ch(0) & ", 0," & delay & "," & interval & "," 

& count & vbLf)
rval = session.ReadString()
n = Len(rval)
i = InStr(rval, ",")
loadz = Val(Left(rval, i - 1))
measv = Val(Right(rval, n - i))
Console.WriteLine(Chr(10) & Chr(10) & "After SPGU output:")
Console.WriteLine("Load impedance   = " & loadz & " ohm")
Console.WriteLine("Terminal voltage = " & measv & " V")
GoTo Close

Check_err: ’76
MsgBox("Instrument error: " & Chr(10) & msg, vbOKOnly, "")

Close: ’79
Console.WriteLine(Chr(10) & "SPGU output stopped." & vbLf)
session.WriteString("CL" & vbLf)
session.IO.Close()
MsgBox("Click OK to stop the program.", vbOKOnly, "")
Console.WriteLine("Program completed." & Chr(10)) ’84

End Sub

End Module

Line Description 

64 to 74 Measures the terminal voltage, calculates the impedance, and displays the result.

76 to 77 Clears the error buffer. And displays a message box to show an error message.

79 to 84 Disables all channels, and closes the connection with the Agilent B1500.
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